Configuring NetWeaver Development Infrastructure (NWDI) in Manufacturing Integration and Intelligence (MII)

Applies to:
SAP Manufacturing Integration and Intelligence (SAP MII) Version 12.1. SAP NetWeaver Composition Environment 7.11 SP3. SAP NetWeaver Development Infrastructure (SAP NWDI). For more information, visit the Manufacturing homepage

Summary
This document will lead you through all steps necessary for the initial configuration of NetWeaver Development Infrastructure and its integration with SAP MII. After all configuration steps are done you will be able to enable NWDI feature via SAP MII Administration UI and use NWDI powered processes, which include versioning, build, change controls etc, in your development of SAP MII content.

Author: Partha Sarathi Roy Chowdhury
Company: SAP labs, Bangalore
Created on: 16 July 2010

Author Bio
Partha Sarathi Roy Chowdhury is with SAP from last 6 years and based out of SAP labs, Bangalore. He is the Product Architect of Manufacturing Integration and Intelligence (MII). Prior to joining SAP, he spent 2 years with Wipro Technologies.
# Table of Contents

Introduction ........................................................................................................................................... 3

Configuring Central System Landscape Directory (SLD) ................................................................. 4

Initial NWDI setup ................................................................................................................................. 7

Configure MII to work with NWDI ....................................................................................................... 11

Using MII along with NWDI .............................................................................................................. 17
  
  Login Options .................................................................................................................................. 17
  
  Create a New Shared Project .......................................................................................................... 18
  
  Share an Existing MII Project ......................................................................................................... 20
  
  Import an MII Project from DTR .................................................................................................... 20

File and Folder Operations .................................................................................................................. 21
  
  Create a New File ......................................................................................................................... 21
  
  Create a New Shared Folder ......................................................................................................... 21
  
  Rename a File .............................................................................................................................. 21
  
  Rename a Folder .......................................................................................................................... 21
  
  Edit a File ..................................................................................................................................... 22
  
  Cut Paste Files and Folders ......................................................................................................... 23
  
  Working with Older Versions of a File .......................................................................................... 23

Preview ................................................................................................................................................. 23

Sync to Version ................................................................................................................................ 24

Activity Operations .............................................................................................................................. 24

Create an Activity ............................................................................................................................... 24

Revert an Activity ............................................................................................................................... 25

Revert Resources of an Activity ........................................................................................................ 25

Activate an Activity ........................................................................................................................... 25

Show status of Build Requests ........................................................................................................ 26

Creating a Custom Action using NWDI ............................................................................................ 27

Deployment and Undeployment of MII Content SCA .................................................................... 32

  
  Deployment of MII Content ........................................................................................................ 32

  Undeployment of MII Content .................................................................................................... 34

MII Content Development – Some Concepts ............................................................................... 35

  
  MII Content development lifecycle .......................................................................................... 35

  MII Content componentization .................................................................................................. 37

Appendix .............................................................................................................................................. 39

  
  Icon Library ............................................................................................................................... 39

Frequently Asked Questions ............................................................................................................. 40

Some Tips .......................................................................................................................................... 44

Related Content ............................................................................................................................... 45

Copyright .......................................................................................................................................... 46
Introduction

This document will lead you through all steps necessary for the initial configuration of NetWeaver Development Infrastructure (NWDI) and its integration with SAP Manufacturing Integration and Intelligence (MII). After all configuration steps are done you will be able to enable NWDI feature via SAP MII Administration UI and use NWDI powered processes, which include versioning, build, change controls etc, in your development of SAP MII content.

The NWDI combines the features and benefits of a local development environment(s) with a server supported development landscape which provides a consistent central environment, i.e. a local IDE is enhanced with a set of central services. The central services provide the development teams with a consistent local development environment and the necessary infrastructure for development though the entire lifecycle of a product. The development infrastructure consists of the following central services:

1. **Design Time Repository (DTR):** DTR is a central storage of design time objects (application source code) that supports distributed versioning. Access to the central storage is through the standard WebDAV and DeltaV protocols.

2. **Component Build Service (CBS):** CBS plays a central role in the realization of the concepts of the NWDI. It offers centralized build services, storage of build results and build tools.

3. **Change Management Service (CMS):** CMS offers services to configuration of the landscape, transport software changes within the landscape and also packaging and delivery of the components being developed using NWDI.

4. **System Landscape Directory (SLD):** SLD provides services to administer the system landscape which usually consists of a number of hardware and software components that depend on each other with regards to installation and upgrades.

5. **Dev Studio (NWDS):** NWDS is the Netweaver Developer Studio, based on Eclipse platform which enables development of Java, J2EE, WebDynpro and a host of other applications. This is already integrated with NWDI.

6. **MII Workbench:** MII Workbench is the development platform for creating MII Content. The MII Workbench of MII 12.1 is integrated with NWDI. Any code object created in MII Workbench can be added to NWDI.
Configuring Central System Landscape Directory (SLD)

- **Step 1**
  In a web browser window open http://<server>:<port>/nwa/cfg-wizard or navigate from NetWeaver Administrator start page http://<server>:<port>/nwa -> Configuration Management -> Scenarios -> Configuration Wizard

- **Step 2**
  If SLD does not exist on the landscape, select the Configuration Task “Initial setup of functional unit SLD” and press “Start” (or “Reexecute” if cancelled before). If the SLD exists and you know the URL (this will be typical for customers with certain experience with SAP software) please go to step 7.
• Step 3
On the next wizard screen, select “Typical” and proceed with “Next”.

![Configuration Wizard: Overview](image)

- Step 4
Type in the Administrator password and the master password intended to be used for newly created users.

![Configuration Wizard: Overview](image)
Step 5
Choose to set up a new local SLD Server, select check box, type an object server name (usually the same as the name of your server) and press "Next" button.

**Configuration Wizard: Overview**

**Initial setup of functional unit SLD**

17%
Step 13 of 57: User Input

**Configuration of System Landscape Directory (SLD) in Default Mode**

**Registration in System Landscape Directory**

- Using existing remote SLD
- Setup a new local SLD Server

**Object Server Name**

- Software will be developed and delivered from this system

ObjectServerName: vdowdev121

Step 6

**Configuration Wizard: Overview**

**Initial setup of functional unit SLD**

100%

✔ Finished "Initial setup of functional unit SLD"
View protocol Return to task list
How do we check that SLD was successful installation of SLD?
Type the URL http://<server>:<port>/devinf in the browser and choose the “System Landscape Directory” link to navigate to SLD and for example see which Software Components are available

**Initial NWDI setup**

- **Step 1**
  Now select the Configuration Task “Initial setup of functional unit Development Infrastructure (DI all-in-one)”.  

![Configuration Wizard: Overview](image)

- **Step 2**
  Enter the Master Password. The wizard will create the users NWDI_ADM (for administrative purposes), NWDI_DEV (representing a developer) and NWDI_CMSADM (communication user).

![Configuration Wizard: Overview](image)
Step 3

In the next step an option to connect to a remote SLD is offered. Customers with existing SLD may choose the option of a remote SLD. The default option can be to use the local SLD, which was installed in the beginning of this guide.

<table>
<thead>
<tr>
<th>Configuration Wizard: Overview</th>
</tr>
</thead>
</table>

**Initial setup of functional unit Development Infrastructure (UI all-in-one)**

Step 70 of 94: Retrieve information about the SLD

**Software Catalog**

The Software Catalog hosted by the System Landscape Directory is the central information repository for products, software components and their dependencies. The Software Catalog is required by the Development Infrastructure for proper operation. By default, the SLD on this host is addressed.

- [System Landscape Directory](#)
- [Software Catalog](#)

- [ ] Connect to a remote SLD
Step 4

The CMS is configured. The CMS Name set to "CMSD12", the Domain set by default to the SID of the NWDI server needs to be changed to "CUST".

Transport directory should contain following SCAs: XMII.SCA (the same one which was deployed to the server), MII_BUILDT.SCA and SAP_BUILDT.SCA (should be already available there).

**Configuration Wizard: Overview**

Initial setup of functional unit Development Infrastructure (DI all-in-one)

81%

Step 76 of 94: Retrieve information for landscape configuration

**Change Management Service**

Change Management Service (CMS) is part of SAP NetWeaver Development Infrastructure (NWDI). It is used to configure development landscapes and transport software changes.

- **Name**: CMSCE1
- **Description**: Change Management Service
- **Transport Directory**: C:snsap\trans/EPS/In/CMS\dowder12\CE1

**Domain**

To give your transport landscape a structure, you must first create a domain. In this domain, you create the individual tracks for the development of your software components, and then connect them to make a transport landscape.

- **Create Domain**
- **Setting up a Domain and a Track (Note 851259)**

- **Name**: CUST
- **Description**: Domain of CMSCE1
Step 5
Do not create a track (uncheck the check box), this will be done better in the next task. For now the initial configuration of the domain is done.

The initial configuration is finished by this step.
Configure MII to work with NWDI

- **Step 1**
  
  Now the configuration for a specific development track begins. This task may be repeated as often as a new development track or software component is needed.

  In the Configuration Wizard overview start the task “Integration of MII with existing NWDI”.

- **Step 2**
  
  Enter the CMS Url or leave the currently displayed URL, enter the password for user NWDI_CMSADM (remember the master password from steps before).
Step 3

Please ensure that the archives MII_BUILDT.sca, SAP_BUILDT.sca and XMII.sca in the corresponding version are available in the transport directory before continuing. If the software component archives are not available, please download them from the SAP Service Marketplace and copy to the transport directory.
• Step 4
Now the checkbox “Create Track” must be set. The Track Name “MII_CUST” and description have to be maintained.

Integration of MII with existing NWDI

Step 23 of 44: Request information about Track and Software Component

Development Track

Specify the details of the track to be used for the creation of the application skeleton, or choose an existing track on the Change Management Server.

✔ Create Track

CMS Name: CMSCE1
Domain Name: CUST
Track Name: MII_CUST
Description: Track for MII Content Development
DTR URL: http://vdowdevl21:50000/dtr
CBS URL: http://vdowdevl21:50000

Software Component Archives

In order to setup the track the template is going to register and import Software Component Archives (SCAs) that provide the necessary sources or build archives for the Software Components in this track.

CMS Host: http://vdowdevl21:50000
Checkin Directory: C:sers\sap\trans\EPS\in\CMS\vdowdevl21CE1

The CMS supports the upload of SCAs via HTTP connections. Select the checkbox if you want to upload SCAs from a local directory to the CMS.

☐ Upload Software Component Archives

• Step 5
The Software Component which is being developed can be named for example MII_CUSTOM. The vendor and version are mandatory, too. The application template “MII Content Development 12.1” needs to be selected.
Configuration Wizard: Overview

Integration of MII with existing NWDI

50%
Step 23 of 44: Request information about Track and Software Component

Software Component

Specify the name, vendor and version of the Software Component you want to develop in this track. Optionally you may assign the component to an existing Product.

Software Components

Components Development with the NWDI

Name: MIL_CUSTOM
Vendor: sap.com
Release: 1.0

Application Template: MII Content Development 12.1
Enhancement Pack: 1

[ ] Attach Software Component to a Product

Next screen should be confirmed by pressing "Next" button.
Step 6

In the last step enter the URL to your SLD (pay attention to possible remote SLD installation), the development configuration name consisting of the <domain name> + "_" + <track name> + "_D" what is CUST_MIICUST_D in default case.

Once these steps are complete the only thing that is remaining is to set up MII to point to the selected NWDI server.

Step 7

Go to the MII System http://<host>:<port>/XMII/Menu.jsp
• Step 8
Select the Menu option Source Control Services -> NWDI Configuration.

• Step 9
Click on the Modify Button in the screen and enter your user credentials

• Step 10
In the next screen enter the following information
a. Select the NWDI Available checkbox.

b. Browse and select or Type in the Development Configuration Name.

c. Select Extended NWDI Support if you want to manually Activate changes and also create Development Components (DCs) with configurable prefix and vendor names. *(Please check for functionalities in italics which will not be available if this is not selected).*

d. If you selected Extended NWDI Support in c please fill in a Support Component. This can be any string.

e. Choose the Authentication Type. Basic is chosen by default.

f. Save the changes. Your MII System is now ready to work with NWDI.
Using MII along with NWDI

Login Options
Open the MII Workbench. In the Workbench you will see an additional Menu item “Source Control” with only the option to Log In. Click on this menu option.

In the Login screen enter the following details:

1. User Name for NWDI system
2. Password
3. Select the Save Password checkbox if you want to save your password
4. Select Auto Login check box if you want MII to log you in to the NWDI System every time you open the workbench. This option automatically selects the Save Password option.
5. Click on OK.

If you are successfully logged in you will see a Success message. Also if you now go to the Source Control Menu option you will see other options like Import Projects, Create Activity, Show Open Activities, Activation View, Show Activation Requests, and Log Off.

Additionally if you open the File menu you will see a new option New Shared Project.

Creating and Importing a Shared Project
Once you have logged in to NWDI from MII you would initially need to create a Shared Project or share and existing project. We will first see how to create a new project and share it in step 1.

Additionally you might want to import a project from DTR to your MII Workbench.
Create a New Shared Project

In this scenario we will create a new project and it will be also added to the DTR system in one shot. The steps are

1. Go to the File Menu and select New Shared Project.
2. In the New Shared Project screen you need to provide the following information
   a. Select the Software Component Name. First name is the list is selected by default
   b. Select the component vendor name.
   c. Select the prefix and provide a Development Component Name. Note that the “prefix.DC name” is defaulted for the project name.
   d. If you want to change the project name you can enter a new name in the project name field
   e. If required enter a description.

Click on OK and you will be prompted to select an activity. Click on Create Activity. Provide an Activity Name and Activity Description and click OK.

Note that this UI will be different in case you have not checked the Extended NWDI Support in step 10 of Section 2.3
Select the newly created activity and click OK.

A success message is shown that the shared project is created successfully. Additionally you can also see the project created in the Workbench with a DC icon.

Till this point the DC or MII Project is not in DTR. To commit these changes into DTR you will need to checkin the changes.

To check in the changes go to the Menu Option Source Control -> Show Open Activities.

Select the Activity in the list shown and click on Checkin.

On successful checkin you will get a confirmation. Now the MII Project is in the DTR system.
Share an Existing MII Project

At times you will already have an MII Project which you might want to add to DTR system. This can also be done from MII Workbench.

To share an existing project right click on the project name and select Source Control -> Share. The Project Share dialog opens with values defaulted as below.

Note that this UI will be different in case you have not checked the Extended NWDI Support in step 10 of Section 2.3

![New Shared Project Dialog](image)

You may change the SC Name, SC Vendor Name and prefix. You can additionally provide a description. Next click on OK and create/choose an activity and click OK as in the previous example.

The remaining steps are same as for a new project. This step creates a new DC and then adds all the files and folders inside this project to the new DC.

Import an MII Project from DTR

If you already have an MII Project in DTR (shared by someone else) that you want to have in your workbench in MII then you will need to import the DC.

To do this you need to go to the menu option Source Control -> Import Project

![Import Projects Dialog](image)

A dialog box showing all the SCs in your Dev Configuration and their DCs are displayed. You can select one or more DCs and click on OK. The projects would be created in your MII Workbench with all their content.
File and Folder Operations

Once you have created a DC and checked in the DC to the DTR System you can start creating content in the project. You can create files and folders in the shared project or check existing files out to modify them. Here we will look at the different options available to work with Files and Folders.

Create a New File

The process to create a new file in a Shared Project is same as the case in normal projects. Additionally here you will need to create an activity or choose an existing activity to associate the new file. The activity would hold the file till you decide to check in the changes. The process is to right click on the folder in which you want to create a file and select New -> <File Type>. Make you changes to the file and save. ‘On save’, system will first ask for the filename and path. Once you click on OK you will be prompted to select an activity. You can select an existing activity or create a new one.

Once the file is added you will see the file in the Workbench added under the path selected by you. The file also has a decorator (‘+’ sign) marking this is a newly added file.

Create a New Shared Folder

To create a new shared folder the process is same as creating a new folder. Right click on the parent folder and select New Folder. Provide a name for the folder. Once you click OK you will be prompted to select an Activity. Create a new activity or select an existing activity and click OK. The folder is created and added to the activity.

Rename a File

At times you would want to rename a file. The procedure is again same as normal files. Additionally in this case you will be asked to choose an activity. The effect of this is that the old file will be checked out for delete (not deleted though) and a new one created with the new name and added to the same activity.

For example I renamed a transaction Test to Test123. The effect is that Test is checked out for delete (Black ‘X’) and a new Test123 (with the same content as Test is created.

Rename a Folder

The process of renaming a folder is same as renaming a file. The only difference here is that all the files under the old folder (the one to be renamed) is checked out for delete. On the other hand all the content of the old folder is copied to a new folder (of the new name chosen) and is added to the activity.
Edit a File

Choose a file you want to edit and open the file. You will see that the file is Read Only. This is shown as below.

In order to modify this file you need to checkout this file. Check out a file by right clicking on the filename and choosing the menu option Source Control -> Check Out. You will be prompted to select an activity. Once you select the activity and click OK the file is added to the activity and also made editable. You will see a lock icon on the file indicating that the file is locked by you.

Open the Properties tab of the file and you can see the Version No of the file and also who locked the file. If a file is not locked then this field is blank.
Cut Paste Files and Folders

If you cut a file or folder from a shared project and paste it in another project you would be asked to select two activities. The first is to checkout for delete the cut resources and the second to checkout for create the pasted resources. You can select the same activity for both operations if the two DCs are from the same SC. If either the cut or the paste is not from a shared project only one activity needs to be selected.

Working with Older Versions of a File

At times it is necessary to check the older version of a file and get the older version if the developer made some changes which do not solve a problem. For this MII provides a Version History of all the changes made to a file.

To access this information you need to select and right click on the file and choose Source Control -> Version History. It shows a screen like below.

![Version History Screen](image)

You can see that the file I chose has 3 versions each showing the activity name and description and the date when it was checked in. It also shows the user who checked in the file.

This UI has two options “Preview” and “Sync To Version”.

Preview

Preview option is to see what was the content of a file in a particular older version. To see the content select the file version and click on Preview. The file is opened in the workbench. The file is read only and also has a text indicating its version number. You can execute this file as well (depending on whether it is executable file or not) but you cannot save the file or do other operations like Checkout or delete.

You can open the current version of the same file and compare the two versions and based on that modify the current version of the file.
Sync to Version

If you want to get an old version instead of the new version that you created the option is to select the version in the Version History table and click on Sync To Version. This option will ask you to choose an activity. The reason is that the Sync To Version checks out the latest version and copies the content of the old version on to the new version. You can then make changes to this code and then check in the changes.

Activity Operations

Throughout this document we talked about creating an activity and assigning changes to that activity. The activity is nothing but a change log. The change log keeps track of changes you are making. The activity can be checked in only in full. Part of an activity cannot be checked in. Check in commits the changes you have made to the DTR.

However if you want to revert the changes you have two options. Either you can revert the whole activity or you can revert some resources from the activity.

Additionally you can activate an activity. Activation is compiling the changes made as part of the checked in activity against the Central Build Server (CBS). Lets now look at each of these operations of an activity in details.

Create an Activity

The first step in using an activity is to create an activity. From the above sections you can see that the Activity creation is prompted in many cases. You can also create an activity without doing any of the previous steps. The process is to go to menu option Source Control -> Create Activity.

Provide the Activity Name, Activity Description (Optional) and choose the Software Component to create the activity for. This is because activities are created for an SC.
Check-in an Activity

An activity which has some resources added to it can be checked in. To check in an activity go to menu option Source Control -> Show Open Activities.

You can expand the activity and see the resources added to this activity. To check in the activity you can select the activity and click on Check In. Once the activity is checked in the files inside the activity is set back to read-only mode and you would need to check them out again in a different activity to modify them.

Additionally you can select the Activate checkbox to activate the activity after check in. We will discuss activation in a separate section.

Revert an Activity

To revert an activity select the activity from Show Open Activities screen and select revert. The changes made to all files in this activity would be removed and the file brought back to the last checked in state. The files would also be rendered read-only and you would need to check them out again to modify them.

Revert Resources of an Activity

The resources (files) of an activity can be reverted separately as well. You can select one/multiple files and click on Revert Resources. The effect for these files is the same in that they lose all changes done and would be made read-only.

Alternately you can also select one/multiple folders and click on Revert Resources. The effect is that all resources in the activity which are children of that folder would be reverted along with the selected folder(s).

However you cannot select some files and folders. You can either select some files or you can select some folders but not both together.
**Activate an Activity**

We already discussed that you can select the Activate check box which checking in an activity. This would automatically activate the activity. Optionally you can also activate your activities in a separate step by selecting the menu option Source Control -> Activation View.

Select the activity and click on Activate. The build request is created and the build happens asynchronously in CBS System. The Build Request ID is displayed and you can track the status of the build request in a separate view.

As this option is only available when you have selected “Extended NWDI Support” for normal cases the activity is activated as soon as it is checked in.

![Activate an Activity](image)

**Show status of Build Requests**

The status of the Build Requests created while activating an activity in Sec 3.1.4.5 you need to select the menu option Source Control -> Show Activation Requests. The resulting screen shows all the activation requests and their status. The different status are Queued, Pending, Successful, Failed.

![Show status of Build Requests](image)

You can click on the Refresh button to get the latest status. The MII System Job “Activation Request Cleaner” cleans up this information periodically. So these entries will be removed from time to time.
Creating a Custom Action using NWDI

An important feature of MII is the ability to create custom actions and plug them to the MII Application. The custom actions were, in the previous releases, created in a Java IDE and built using build tools like ANT and archived as a .jar file. The archive was then deployed on to the MII Server.

1. In your NetWeaver Developer Studio go to Windows -> Preferences -> Development Infrastructure -> Landscape Directory. In this please enter the URL to the SLD server of your NWDI system where track for MII development is available. Click on OK.

2. Go to the menu option “Create/Import Development Configuration” and select “Import from System Landscape Directory” and click Next.

3. Select the track for MII Development track and click on Next and Finish. Provide your username and password for this track. The track is added to your NWDS.

4. Select the correct Software Component in the track for development and sync the already create MII DC. (This is the one you have created in MII workbench). To sync the project right click on the project and choose “Sync/Create Project -> Create Project”.

5. Choose all the dependencies of the dc, uncheck the checkbox “Build DCs after Sync” and click on OK.

6. Now to create a custom action we first need a Java DC. Create a Java DC by right clicking on the SC name and select “New -> Development Component”.

7. Choose DC Type as Java.
8. Fill in the entries as shown below and click on Next. Create an activity and finish the DC Creation.
9. Select the DC from the DC List and select the Component Properties view. Select the Dependencies tab and click Add. Here we will add the dependencies to the required DCs. Select the DCs xapps/xmii/common and xapps/xmii/classes from the XMII SC.

![Adding Dependencies](image)

10. Remove the added dependency for all other Public Parts except for bls_sdk for both classes and common DCs. Click Finish. After you did this it should look like below. Sync the required DCs.

![Dependency Details](image)

11. Go to the Public Parts tab and click on Add. Add a Public Part of type Assembly. You can give any name you want.

12. Go to the Java Perspective and open the custom action DC. Create your package for the Custom Action. Add a Java Class to this package.

13. Create a method for your action. Unlike in MII 12.0 the custom actions are now individual methods instead of individual classes. The method uses annotations to create the Output and Input parameters. Here is an example
You can add as many methods to this class as you want for different actions.

14. Create a package for storing the icons under src package and add all your icon files there.

15. Create a catalog.xml file directly under the src package. The entries in this xml should look like below:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<ComponentCatalog>
  <Category Name="Field Data Capture" Description="Field Data Capture">
    <Component Type="Action" Name="SampleAction" Description="Sample Action"
      Label="Sample Action" ClassName="com.sap.mii.customactions.SampleAction"
      AssemblyName="sap.com~tmp~fcustomactions.mii-actions" HelpFileName=""/>
  </Category>
</ComponentCatalog>
```

Note the extension of the AssemblyName is "mii-actions".

16. Go to the Development Configuration perspective and select the Custom Action DC. Open the Public Parts tab in Component Properties and select the Public Part created earlier. Right Click and select Manage entities:
   a. Select the option File and select the catalog.xml
   b. Select the Folder sub tree option and select the root of your package structure.
   c. Perform step b for your icon package as well.

After completion the public part should have something similar to

```java
@Action(name = "IntervalCount",
       icon = "/com/sap/xmlui/xacute/actions/resources/icons/WebScrapper.png")
@Outputs(names = {"IntervalCount", "EndTimeStamp"},
         types = {VariantDataTypes.INTEGER, VariantDataTypes.CALENDAR})
public static boolean htmlScrape (IActionInstance action,
       @Input(name = "StartTimestamp") Calendar startTime,
       @Input(name = "CurrentTimestamp") Calendar currentTime,
       @Input(name = "FrequencyCode") Integer frequencyCode,
       @Input(name = "FrequencyValue") Integer frequencyValue) throws Exception {
```
17. Go to the MII project DC and select the Dependencies tab in the Component Properties view. Here we will add a dependency to the MII Actions DC so that the MII Build Plugin can pick it up during archive creation.

   Click on Add button. Select the MII Custom Action DC and select the public part. After this step the dependency list should show as below

   ![Dependency list](image)

18. Go back to Java DC and select the custom action DC. Right Click and select Build. The project should build correctly. Resolve any build issues till this project builds correctly.

19. Checkin and activate the changes. Transport the changes. Once the changes are there in CMS the SCA can be built and deployed on to MII System.

   This completes the process of creating custom actions.
Deployment and Undeployment of MII Content SCA

Deployment of MII Content

Deploying an MII Content is pretty simple. It is same as any other SCA deployment. The only thing to remember is that the user used to deploy the MII Content SCA would need to have MII Administrator roles.

You can deploy an SCA from the NWDS by the following steps:

1. Save the SCA in a local folder in the system where NWDS is installed.
2. Open the NWDS and go to Window -> Preferences -> SAP AS Java. Enter the Server HostName and Instance ID to add the J2EE Engine where MII is running and you want to deploy the archive. Click on OK. The System ID should be shown and the entry added to the System List. Click on the checkbox Default System.
3. Open the view “Deploy View” from Window -> Show View -> Others.

4. In the deploy view select the entry “Deploy External Archives” and click on the ‘+’ sign. Select the required SCA file.

5. Click on the Deploy icon or right click on the file and choose deploy. In the dialog click OK. You should see a confirmation of deployment.

6. Login to MII as Super Administrator and go to Projects screen. You will see the deployed projects from this SCA with the details of the component name. The project type is set as deployed project.

7. You can try to delete the project from here but it is strongly advised against. Deployed projects should only be removed by undeployment as described in the next section. Also notice that a deployed project cannot be exported.
8. You can also log on to the MII Workbench. Here the deployed projects are shown with the blue Development Component decorator as shown below.

Undeployment of MII Content
To undeploy an MII project which was deployed earlier you need to follow the below steps:

1. Go to NWDS and open the Undeploy View from Window -> Show View -> Others. You might need to provide the Administrator login credentials for your J2EE Engine.

2. In this view you can select the name of the SCA/sda you have deployed. Select and click on "+" sign. It will show all the projects and custom actions deployed with this archive.
3. Click on the Undeploy icon. You should get the Undeploy success message. You can check in MII if all the projects and custom actions have been removed correctly.

MII Content Development – Some Concepts

MII Content development lifecycle

Standalone MII Development (in versions prior to 12.1 and also optionally in 12.1) was based on manual import and export of MII Content from the development system to the production system as depicted in the diagram below.

For development based on MII integrated to NWDI this is not required any more. Most of the steps are now automated based on SAP NWDI infrastructure. The code can be moved between tracks and then can be deployed on the production servers automatically using NWDI.
The actions needed to achieve this are Check Out and Check In of the code by the developer, Activation of these changes and Release of Transport Requests.

The above diagram shows the path of the changes based on each of the above operations.
**MII Content componentization**

The MII DC created in MII Workbench is of type Content/MII Content. The MII Custom Actions are of Java DC type and the dependencies are of External Library type. Both these need to be created in the NWDS.

The MII Content Development lifecycle includes the steps as

1. **Build** – Creates an SDA file. This step is executed in the CBS system.
2. **Assembly** – Creates the SCA File by combining one or more SDA files. This is done in the CMS system.
3. **Deployment** – Done by the MII Content Handler running on individual MII Servers. This is invoked by the separate deployment mechanisms of NWDI.

MII Content DC has the following features.

1. It intends to store a content of an MII Project
2. It is built by a build plugin called xapps/mii/bp located within MII_BUILDTS.
3. It is deployable DC MII handles during deployment.
4. It is able to assemble MII Custom Actions in it that they can get deployed together.
5. It can only be created in MII Workbench.

The MII DC Dependency can be defined by following the below diagram. This is already explained in "Creating a Custom Action using NWDI".

Once deployed an MII Project behaves slightly differently than the normal project. Here are some of the features.

1. Deployed Project is a special type of MII Projects
2. MII creates a deployed project when an MII Content DC gets deployed
3. Deployed Project is visible in MII Workbench
4. Deployed Project cannot be modified, it can only be customized
5. Deployed Project is updated when new version of MII Content DC gets deployed
6. Deployed Project is removed when corresponding MII Content DC gets undeployed
Appendix

Icon Library

The list below shows all the different icons displayed on the MII Files and Folder for NWDI States and their corresponding meaning.

- Development Configuration
- Deployed Development Configuration
- Shared Project

- Software Component
  - Resource Checked out
  - Resource Checked out by others
  - Resource Checked out for create
  - Resource Checked out for delete

- Open Activity
  - Closed Activity
  - Folder checked out
  - Resource out of sync
  - ReadOnly resource
  - Resource is local inside a shared project

- Folder checked out by another user
Frequently Asked Questions

1. While configuring MII to work with NWDI it asks for an username and password. Which username and password to use?

   You should provide the username and password for the NWDI/SLD system. If they are different it should be SLD server username and password.

2. From the MII Workbench I need to login again to the Source Control. Which username and password should this be?

   If the SLD server and NWDI server are on the same UME engine then it should be the same username and password. Else you need to provide the DTR System username and password.

3. I have installed and configured the NWDI. However, when trying to create a project, I am receiving the error "Error occurred while getting list of allowed development component vendor names. Name server not configured" error.

   This means that you have not set the SLD Server as Name Server. Login to your SLD Server using the URL http://<host>:<port>/sld. On the right hand you will see a link “Name Reservation”. Click on this link. In the next page you will see a button which says "Enable this SLD as Name Server for NWDI". Click on this button. The button should change to "Disable this SLD as Name Server for NWDI".

   Next go to CMS Server and select the Landscape Configurator. Select the Dev Config that you are using in MII. Click on Edit and change the description a bit and save. Now retry the steps in MII.

4. "Import Software Components" failed while executing the CTC template for NWDI configuration.
   a. Logon to the CMS system http://<server>:<port>/devinf -> CMS.
   b. In CMS the domain and track are selected. The needed software components are listed but not imported. Mark and import. In case of an error (status "Import failed") switch to CBS. Go to the buildspaces, mark the track, set the parameter "Input" to “OPEN” instead of “PRIVILEGED” (actually locked).

5. A popup is displayed, saying that the configured build archives could not be found in the Transport Directory

   Check that the Transport Directory (for example: C:\usr\sap\trans\EPS\in\CMSWDFN00203791ADI6 ) is correctly created during installation and the archives are copied to this directory before the track and software component creation were started. If everything is correct but the archive uploading is still creating an error, change the User on the Windows Services of your SAP system from “Local Service” to a User with Administrator privileges. You need to restart the system to make the user changes active.
6. How to optimize CBS performance?

When MII and NWDI services run on the same machine they share same system resources. Central Build Service (CBS) is responsible for central build of all components which are developed in NWDI tracks. Sometimes build process will take up to 100% CPU time what will slow down the overall system performance (not only NWDI but also MII will be affected). To avoid potential performance problems it is desired that CBS owns a single CPU for its needs. Thus MII + NWDI constellation could run on the same server but with at least two CPUs. If you decided to install them onto the same machine with a single CPU you should optimize CBS settings to get acceptable performance.

   a. Ensure you have latest Sun JDK installed. If you don't have one download it from java.sun.com site and install on the same machine where CBS runs.

   b. Start SAP NetWeaver Config tool available under \usr\sap<Instance>\J00\j2ee\configtool folder.

   c. Find tc.CBS.Service item in the list of services and select it.

   d. Change the CBS properties as described below:

      i. BUILD_TOOL_JDK_HOME [d:\jdk1.5.0_16]
         Value must point to local folder with jdk

      ii. BUILD_TOOL_VM_ARGS [-Xmx384M -Xms200M]
          Value should contain reduced memory settings

      iii. JDK_HOME_PATHS
           [JDK_1.5.0_HOME=d:\jdk1.5.0_16;default=d:\jdk1.5.0_16]
           Value must point to a locally installed JDK (not JRE). Default CBS value is not allowed here!

      iv. threadPoolSize [1]
          Value should contain 1 (the max number of parallel build threads)

   e. After values are changed press "Apply Changes" button and restart NetWeaver Application Server cluster
I have a large MII Project (> 100 MB). When I try to add it to version control it throws an exception: “When user works with a big project MII has to send big amount of data to a DTR server and receive it back. As these operations can take quite long time, user has to increase connection timeout values for MII Workbench and SDIC service and additionally adapt runtime parameters of Internet Communication Manager (ICM). If you plan to work with the projects which size is about 100 Mb or bigger you should consider to perform high-volume data configuration.”

For managing large project files, we need to look at the parameters in NWDI and MII. Here are the details of each step:

**Step 1: Configure ICM max request size and timeout**

**Open <INSTANCE_ID>_J00_<SERVER_NAME> file and add or update the property below**

```
icm/HTTP/max_request_size_KB = 204800
```

Configuration above will allow requests with the amount of data greater than 200MB to be sent to DTR through ICM. You can change this value upon your needs. Value -1 means unlimited.

**Step 2: Configure SDIC timeout**
Configuring NetWeaver Development Infrastructure (NWDI) in Manufacturing Integration and Intelligence (MII)

Open NWA on the system where MII runs and configure SDIC properties

Set value on sdi.nwdiservers.readtimeout property

Value of 1800000 defines 30 minutes timeout. This value can change depending on the configuration of your NWDI landscape.

Step 3: Configure ICM timeout

Browse file system on the server where MII instance runs.

Open <INSTANCE_ID>_J00_<SERVER_NAME> file and add timeout configuration for HTTP server port as it is described in SAP Note 824554

```
icm/server_port_0 = PROT=HTTP,PORT=50000,TIMEOUT=60,PROCTIMEOUT=1800
```

This is example configuration sets HTTP port read timeout to 30 minutes (1800 seconds)

Restart NetWeaver server on which MII is running
Step 4: Configure MII Workbench timeout

Launch MII Workbench and configure timeout as it is shown in the picture below.

Timeout is a time in milliseconds. During this time MII Workbench won’t close data connection to a server even if server does not answer.

Value of 1800000 defines 30 minutes timeout for Workbench. This value can change depending on your landscape configuration.

Some Tips

To work with MII and NWDI there are some things you can do to ensure you do not run into trouble.

1. Try not to revert activities created in MII from some other application like NWDS or the DTR Web UI. This will create inconsistent state in MII as MII would not know that the files were reverted.

2. Try not to have too many open activities with too many files checked out in them. This will make your work hard to organize. This also slows down the system.

3. Check-in activities whenever the changes are completed.

4. Keep only those Shared Projects which you need. The rest can be removed. You can always bring them back later.

5. Do not share projects/files which does not need to be shared. Again this will increase the load on your DTR system.
Related Content

The following outline will document the many available resources to resolve problems, find relevant information and simply to find additional information regarding a certain SAP component or product.

**SAP Service Marketplace** ([http://service.sap.com](http://service.sap.com))

The focus of this site is to provide a source for many portals that can deliver information on specific content. You can find SAP Notes, which contain information on different releases of software. Login authentication is required.

- [http://service.sap.com/instguides](http://service.sap.com/instguides) to download installation and technical guides
- [http://service.sap.com/pam](http://service.sap.com/pam) to view available platforms for different MII versions
- [http://service.sap.com/notes](http://service.sap.com/notes) to view notes applicable MII known issues and solutions
- [http://service.sap.com/quicksizer](http://service.sap.com/quicksizer) to size your NetWeaver instance
- [http://service.sap.com/message](http://service.sap.com/message) to put in problem tickets

**SAP Developer Network** ([http://www.sdn.sap.com](http://www.sdn.sap.com))

SAP Developer Network (SDN) is an active online community where ABAP, Java, .NET, and other cutting-edge technologies converge to form a resource and collaboration channel for SAP developers, consultants, integrators, and business analysts. SDN hosts a technical library, expert blogs, exclusive downloads and code samples, an extensive eLearning catalog, and active, moderated discussion forums.

- [Link](http://www.sdn.sap.com) for MII Forum to research technical solutions and post questions in a community environment
- [Link](http://www.sdn.sap.com) for MII Wiki on SDN
- [Link](http://www.sdn.sap.com) for MII Articles on various technical topics
- [Link](http://www.sdn.sap.com) for MII sample projects and tools
- [Link](http://www.sdn.sap.com) to the NWDI Forum on SDN
- [Link](http://www.sdn.sap.com) to Wiki for NWDI

**SAP Education** ([http://www.sap.com/education](http://www.sap.com/education))

SAP Education provides a catalog of all training courses available including MII courses. Courses available are instructor lead, online learning for Ramp Up projects (RKT), and Online Knowledge Product (OKP).

- [http://service.sap.com/rkt](http://service.sap.com/rkt)
- [http://service.sap.com/okp](http://service.sap.com/okp)


This website houses and makes available all online documentation (SAP Library) for SAP solutions. It also has additional information about documentation, education services, and information design at SAP.
Configuring NetWeaver Development Infrastructure (NWDI) in Manufacturing Integration and Intelligence (MII)

Copyright
© Copyright 2010 SAP AG. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

Microsoft, Windows, Excel, Outlook, and PowerPoint are registered trademarks of Microsoft Corporation.

IBM, DB2, DB2 Universal Database, System i, System i5, System p, System z, System z10, System z9, z10, z9, iSeries, pSeries, xSeries, zSeries, eServer, zVM, z/OS, i5/OS, S/390, OS/390, OS/400, AS/400, S/390 Parallel Enterprise Server, PowerVM, Power Architecture, POWER6+, POWER6, POWER5+, POWER5, POWER, OpenPower, PowerPC, BatchPipes, BladeCenter, System Storage, GPFS, HACMP, RETAIN, DB2 Connect, RACF, Redbooks, OS/2, Parallel Sysplex, MVS/ESA, AIX, Intelligent Miner, WebSphere, Netfinity, Tivoli and Informix are trademarks or registered trademarks of IBM Corporation.

Linux is the registered trademark of Linus Torvalds in the U.S. and other countries.

Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either trademarks or registered trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Oracle is a registered trademark of Oracle Corporation.

UNIX, X/Open, OSF/1, and Motif are registered trademarks of the Open Group.

Citrix, ICA, Program Neighborhood, MetaFrame, WinFrame, VideoFrame, and MultiWin are trademarks or registered trademarks of Citrix Systems, Inc.

HTML, XML, XHTML and W3C are trademarks or registered trademarks of W3C®, World Wide Web Consortium, Massachusetts Institute of Technology.

Java is a registered trademark of Sun Microsystems, Inc.

JavaScript is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.

SAP, R/3, SAP NetWeaver, Duet, PartnerEdge, ByDesign, SAP Business ByDesign, and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of SAP AG in Germany and other countries.

Business Objects and the Business Objects logo, BusinessObjects, Crystal Reports, Crystal Decisions, Web Intelligence, Xcelsius, and other Business Objects products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of Business Objects S.A. in the United States and in other countries. Business Objects is an SAP company.

All other product and service names mentioned are the trademarks of their respective companies. Data contained in this document serves informational purposes only. National product specifications may vary.

These materials are subject to change without notice. These materials are provided by SAP AG and its affiliated companies ("SAP Group") for informational purposes only, without representation or warranty of any kind, and SAP Group shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP Group products and services are those that are set forth in the express warranty statements accompanying such products and services, if any. Nothing herein should be construed as constituting an additional warranty.